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Product overview
IBM WebSphere Operational Decision Management Integration with the SPSS Predictive
Analytics Suite helps youmake better operational decisions using business rules and predictive
analytics.

Traditionally, predictive analytics have been used in an offline mode to help people make
better decisions – decisions that take into account insights about the possible future, based on
analysis of historical data. Recently, there has been increasing interest in leveraging predictive
models within the operational environment, at the point at which an automated or
semi-automated decision is being made by people or by systems. This emerging discipline is
often referred to as Decision Management.

Business rules are frequently used to express corporate policies and human expertise, and
they are increasingly managed and deployed within operational systems using Business Rule
Management Systems (BRMS).

Using business rules and predictive analytics together can lead to improved operational
decisions. Predictive insight can be injected into business rules in a few different ways:

Business rules can be written incorporating the results of predictive model execution
directly into the business rule text

For example, consider a business rule that dynamically computes product prices in realtime
on an online retail travel website. Several regression models are run each week on the
prior week’s data, one for each product line, and the coefficients produced by these models
are directly copied into the business rules that calculate the price. This results in business
rules that take into consideration the most recent trends in customer behavior when
computing the price.

Business rules can be generated from or written based on a predictive model
Examples of this are Decision Tree models and Association models, where the model
itself, or selected parts of it, are naturally represented in the form of business rules.

Business rules can be written that reference predictive scores at runtime
This approach requires that the predictive models be deployed in the runtime environment
and be available for execution by the BRMS when a score is needed.

This SupportPac provides two features that support the usage of business rules and Predictive
Analytics together:

♦ PMML Import of Decision Tree models

♦ Operational Decision Management runtime integration with the SPSS Scoring Service
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PMML import of Decision Tree models
You can create a decision tree from a PMML Decision Tree model, for authoring and
deployment in Operational Decision Management. Decision Tree models are commonly used
for predicting a variable, for example, the probability of a customer purchasing a particular
product. The model is typically created by a statistical analyst.

You import a PMML TreeModel into an Operational Decision Management decision tree to
visualize and understand its content, and then modify, manage, and deploy the resulting artifact
as you would do with any other decision tree. While a PMML TreeModel only generates a
score, in Operational Decision Management you can decorate the leaf nodes of the model
with additional actions to take.

Operational Decision Management also addresses cases not covered by the original Decision
Tree model:

♦ Cases that were not indicated by the training data used by the data mining expert to create
the PMML file.

♦ Cases where you want to experiment with different scores/decisions that are not generated
by the TreeModel creation algorithm but make sense from a business perspective.

The sections that follow describe the interaction between the Decision Tree model, PMML
TreeModel files, and decision trees. Specific instructions on how to import PMML files in
Operational DecisionManagement are provided in Importing PMML in Operational Decision
Management.

Decision Tree models
Decision Tree models are produced by data mining algorithms (such as CHAID, C&RT, ID3,
C4.5/C5.0) that identify various ways of splitting a dataset into branch-like segments, forming
an inverted tree that starts with the root node at the top of the tree. Decision Tree models are
used frequently in the data mining community for classification and prediction as they are
easy to understand, easy to use, support both quantitative and qualitative measurements, and
are very robust. Data mining workbenches, like SPSS Modeler, provide rich toolsets for
creating and validating Decision Tree models.

The following image shows a Decision Tree model in SPSS Modeler:
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PMML files
PMML (Predictive Model Markup Language) is the leading standard for statistical and data
mining models. It uses XML to represent mining models, so that models can be shared. In
other words, using PMML, models can be developed on one system using one application
and deployed on another system using a different application.

PMML is an open source project (see http://sourceforge.net/projects/pmml/). You can validate
your PMML document on the DMG.org website (http://www.dmg.org/converter).

Operational Decision Management decision trees
In addition to supporting the authoring, management, deployment, and execution of business
rules as artifacts, Operational DecisionManagement also supports decision tables and decision
trees. Decision trees provide a convenient way of viewing and managing sets of business
rules, especially when the rules are asymmetrical in structure. In a decision tree, the path from
the first condition (or root node) to the action (or leaf node) corresponds to one business rule.
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The primary difference between a Decision Tree model, as used in the data mining community,
and an Operational Decision Management decision tree is that the decision tree has actions
attached to the leaf nodes while the Decision Tree model usually has some sort of predicted
variable or classification attribute specified for each node. In other words, a Decision Tree
model can identify the business rules for classifying and predicting a specific variable, whereas
the decision tree can actually execute those business rules along with the appropriate actions
at run time.

Operational Decision Management runtime integration with the
SPSS Scoring Service
This section describes Operational Decision Management runtime integration with the SPSS
Scoring Service. See Invoking the SPSS Scoring Service for specific instructions on how to
invoke the scoring service.

The SPSS Scoring Service
SPSS’s Collaboration and Deployment Services (C&DS) product provides a platform for
collaboration, management, and deployment of SPSS statistical and predictivemodels. Through
its scoring service, C&DS can deploy predictive models as scores that can be used within key
business processes to make better decisions. The scoring service is optimized for real time,
and includes the ability to cache data and models and handle multiple sources of input data,
including data gathered through real-time interactions. Using the scoring service, scoring may
be applied at various points in business processes, and scores can easily be integrated with
existing applications using web service calls.
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Writing business rules that reference predictive scores
Leveraging the SPSS Scoring Service, Operational Decision Management users can author
business rules that reference predictive scores. These scores are then retrieved at runtime,
when the business rules execute.

The following image shows a business rule referencing a predictive score:
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Installing
To correctly install and configure the SupportPac:

1. Verify that your environment corresponds to the supported platforms for the SupportPac.

2. Unzip the SupportPac deliverable in the Operational Decision Management installation
directory.

3. Install the predictive analytics features from Rule Designer.

Supported platforms
The SupportPac supports the following platforms:

♦ Operational Decision Management 7.5.0.1

♦ JDK 6.0 or higher

♦ WebSphere Application Server 7.0, fixpack 17 or higher

♦ SPSS Collaboration and Deployment Services v 4.2

♦ Platforms: Windows, Linux.

♦ PMML version 3.2 and 4.0 TreeModels (with some limitations), as generated by SPSS
PASWModeler V13 or V14. See PMML support for more details on the limitations.

Unzipping the SupportPac deliverable
To begin your installation of the SupportPac, unzip SupportPacLB02v2.1.zip in the
Operational Decision Management 7.5.0.1 installation directory (<WODMInstallDir>),
typically C:\Program Files\IBM\WODM75.

The SupportPac requires Operational Decision Management 7.5.0.1 or higher.Warning:

This adds<WODMInstallDir>/SupportPacs/SupportPacLB02/ in the distribution
structure, with the following folders and files:

♦ readme.html: Readme file.

♦ lib/: Runtime JAR files required for execution.

● jrules-analytics-runtime.jar

● commons-collections-3.1.jar
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● commons-lang-2.1.jar

● velocity-1.5.jar

♦ license/: License files.

♦ eclipse/

● features/

● plugins/

♦ samples/: Sample files.

● import: PMML TreeModel sample files used in decision tree import:

♦ iris-tree-spss-3.2–chaid.xml: Decision tree for the classification of iris
trees, in PMML 3.2.

♦ samplePMML-3.2.xml: Decision tree for determining whether to play tennis,
according to temperature, wind, humidity, and so on, in PMML 3.2.

♦ newschan-spss-3.2.xml: Prediction for a consumer to subscribe to a news
channel, using a decision tree in PMML 3.2.

● scoring service: PMML or SPSSModeler Stream sample files to deploy to SPSS
C&DS 4.2, for runtime calls:

♦ KMeans.xml: Medical analysis clustering model using the KMeans method.
Prediction of the patient’s category according to some indicators in the blood analysis.

♦ Gender.xml: Prediction of the gender of the patient, according to some indicators
(age, blood pressure, cholesterol level).

♦ BP-Bayes.str: SPSSModeler 14.1 streamfile, with a Bayesian network. Prediction
of the blood pressure according to age, sex, and cholesterol level.

Installing the Predictive Analytics features
To install the SupportPac features in Eclipse, run the Eclipse Update Site:

1. In Rule Designer, click Help > Install New Software.

2. In the Available Software dialog, click Add, then click Local, and then browse to select
the directory<WODMInstallDir>/SupportPacs/SupportPacLB02/eclipse.

3. Click OK, and then OK again to add the new update site. It should now appear in your
list of update sites.
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4. Select IBMWebSphere Operational DecisionManagement integration for the SPSS
Predictive Analytics Suite (LB02), and then click Next.

5. Confirm by clicking Next and accepting the license conditions, and then click Finish.

Click OK if you get a warning about unsigned
content.

Note:

6. Click Restart Now to restart Eclipse.

To uninstall the SupportPac features:

1. In Rule Designer, click Help > Install New Software.

2. In the Available Software dialog, click theWhat is already installed? link.

3. In the Installed Software tab, select IBMWebSphere Operational Decision
Management integration for the SPSS Predictive Analytics Suite (LB02), and click
Uninstall.

4. In the Uninstall dialog, select the entry and click Finish.

5. Click Restart Now to restart Eclipse.
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Importing PMML in Operational Decision
Management

You import a PMML TreeModel into an Operational Decision Management decision tree to
visualize and understand its content, and then modify, manage, and deploy the resulting artifact
as you would with any other decision tree.

In this section

Overview
After you export a Decision Tree model from a modeling tool to a PMML file, you can import
it into a decision tree.

PMML support
PMML import in Operational Decision Management can be done on files that meet certain
requirements and limitations.

Importing a PMML file to a decision tree
You use the Import PMML Decision Tree wizard to import a PMML file into a decision tree.

Integrating the decision tree into the rule project
When importing a PMML file into a decision tree, create a XOM class corresponding to the
BOM entry.
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Overview
The Operational Decision Management PMML import feature focuses on the Decision Tree
model. After your Decision Tree model has been exported from a modeling tool to a PMML
file, you can import it into a decision tree. The following image shows the workflow:

PMML supports a wide array of data mining models in addition to decision tree models.
If you have other types of models that produce scores that you would like to leverage

Note:
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within your Operational Decision Management application, you may want to invoke the
scoring service instead, as described in Invoking the SPSS Scoring Service.

To correctly import a PMML file into a decision tree:

♦ Make sure that your PMMLfilemeets the requirements and limitations (seePMML support).

♦ Follow the step-by-step instructions to importing (see Importing a PMML file to a decision
tree).

♦ Complete the integration of your decision tree into the rule project (see Integrating the
decision tree into the rule project).

After your PMML TreeModel file has been successfully imported, it becomes a standard
decision tree artifact and can be edited, managed, and deployed like any other decision tree.
However, the import of PMML TreeModels containing compound or simple set predicates
may result in irrelevant messages being produced by the overlap and gap checker in the
decision tree editor. To remedy this, turn off overlap and gap checking at either the node or
tree level.

An imported decision tree currently has no life-cycle link to the PMML file. Consequently,
if you change the PMML model itself, you will have to repeat the import/modification
process.

Note:

See also
Product overview
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PMML support
The PMML import feature supports PMML 3.2 and 4.0 TreeModels generated by IBM SPSS
Modeler V13 or V14. PMML 3.2 TreeModels generated by other tools or by previous versions
of IBM SPSS Modeler may also work with this feature.

You can validate your PMML file on the DMG.org website (www.dmg.org/converter). This
utility provides validation of PMML files, as well as conversion from older versions.

Tip:

The PMML file must be a well-formed PMML 3.2 or 4.0 document consisting of at least the
following elements:

♦ Header

♦ DataDictionary

♦ TreeModel

♦ MiningSchema: Must contain a MiningField element for each field referenced in
the generated decision tree. There must be one (and only one) field with a FIELD-USAGE
-TYPE of predicted.

♦ MiningField

♦ Node: Each node in the PMML TreeModel must contain a value for the Score attribute.

General information on PMML can be found here: http://public.dhe.ibm.com/
software/dw/industry/ind-PMML1/ind-PMML1-pdf.pdf

Note:

The Operational Decision Management PMML import feature does not execute PMML.
Rather, it uses the PMML TreeModel as a basis to generate business rules in the form of a
decision tree artifact.

After the TreeModel has been imported, the generated decision tree may be manually
transformed by the user, if necessary, to produce a decision tree that makes sense within the
context of the deployed business application. In other words, you can import a design time
artifact that will be transformed into executable business rules that can be managed and
deployed in the BRMS.

Operational Decision Management decision trees are not currently able to persist all of the
metadata contained in a PMML TreeModel. In the generated decision tree, you will find:

♦ On each node: The name of the attribute being tested.
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♦ On each branch: The test conditions being applied to the attribute in the node where the
branch originates.

♦ On each leaf node: The value of the Score attribute from the corresponding leaf node in
the PMML TreeModel.

Additional metadata that may be associated with the PMML TreeModel node and displayed
in SPSS Modeler and other Data Mining tools will not be displayed in the decision tree. The
most common examples of this kind of metadata are: the Score Distribution value, the Score
Distribution RecordCount, and the ScoreDistribution Confidence.

Assumptions
Many of the PMML elements that you may commonly encounter in a PMML TreeModel are
not relevant in the proposed design-time approach, and will simply be ignored.

These elements are listed under the following sections:

♦ Data manipulation

♦ Unknown and missing values

♦ Presence of a value for the Score attribute

Data manipulation
The following elements are used to manipulate input fields, predicted values, and output fields.
Since the import feature imports the PMML rather than executing it, these elements are not
used during decision tree generation:

Data transformations
PMML import ignores data transformations (TransformationDictionary,
LocalTransformations, DerivedField). This information can be useful to the
Operational DecisionManagement application developer when configuring the BOM and
XOM, to help ensure that the right data will be provided to Operational Decision
Management at runtime.

Target
Ignored by PMML import. They are typically used to manipulate the predicted value
generated by a model.

Output
The additional output fields that might be generated when a PMML file is executed are
not relevant when authoring a decision tree. However, if these additional output fields are
important to your application processing, you should consider executing your Decision
Tree model using a Scoring Service, rather than transforming the model into a decision
tree for execution.
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Unknown and missing values
There are a number of constructs within PMML that are used to specify how unknown and
missing input values are handled during PMML execution of the TreeModel. These constructs
are not supported when importing PMMLTreeModels into Operational DecisionManagement,
because it does not support the notion of missing values. Rather, it is the responsibility of the
Operational Decision Management developer to ensure that the data model is properly
configured and that the necessary data is made available to the Decision Service at runtime.

As a result, the following elements are handled in the following ways:

♦ missingValueStrategy: Ignored.

♦ missingValuePenalty: Ignored.

♦ Surrogates: Ignored. If the surrogate operator is used within a compound predicate,
the first predicate in the sequence will be selected by default.

♦ missingValueReplacement: Ignored.

♦ missingValueTreatment: Ignored.

Presence of a value for the Score attribute
Since there will always be a score attribute for a given node, noTrueChildStrategy
and the ScoreDistribution element are ignored.

Limitations
The following PMML constructs are not supported, ignored, or otherwise handled by PMML
import:

♦ Vendor-specific extensions: Any occurrences of the PMML Extension element will be
ignored during import.

♦ Multiple models: If there is more than one TreeModel in the PMML file, only the first one
will be processed, and the rest will be ignored. If there are other (non-TreeModel) model
elements in the PMML file, they will also be ignored. Model composition
(EmbeddedModel element), and segmentation (Segment orSegmentation elements)
are not supported. Also, the MiningModel element is not supported, so Decision Tree
Ensembles cannot be processed.

♦ DataFields, Datatypes, and Optypes.

● There are several PMML date formats that are simply treated as int datatypes (see
Reference for a full listing).

● Intervals: Continuous Datafields with defined intervals will be treated like regular
continuous fields.
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● Taxonomy: If a categorical Datafield references a Taxonomy, it will be treated like
a categorical field without declared Values.

● Cyclic elements: The Cyclic designation will be ignored on continuous and ordinal
DataFields. This should not pose a problem, as this element is used in Clustering models,
not Decision Tree models).

♦ Operators

● The LessThan and GreaterThan operators on Ordinal Optypes are not supported.

● The boolean operator XOR is not supported.

● The boolean operator Surrogate is not supported.

● The isMissing and isNotMissing operators are not supported.

See also
Overview
Type support for PMML import
Importing a PMML file to a decision tree
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Importing a PMML file to a decision tree
When you use PMML TreeModels in decision trees, the Operational Decision Management
rule project must contain:

♦ A BOM class on which the PMML TreeModel elements are mapped. This class must have
one attribute per PMML field and a default verbalization for each of these elements.

♦ An instance of the above BOM class as ruleset parameter. This ruleset parameter must also
have a verbalization.

There are two possible cases to consider before importing:

The BOM class for the PMML TreeModel does not exist.
This typically occurs:

♦ The first time you import a PMML file into a given rule project.

♦ When the PMML fields of the file you want to import are completely different from
the BOM class you generated in a previous import, so you need a new BOM class.

In either of these cases, you want the Import PMML Decision Tree wizard to generate
both the BOM class and the corresponding ruleset parameter, define a default verbalization
for them, and then create the decision tree using the default verbalizations.

In the case of subsequent imports requiring a different BOM class, the Import PMML
Decision Tree wizard can generate a different BOM class type and verbalization, as well
as a different ruleset parameter name and verbalization to avoid conflicts with PMML
TreeModels that you previously imported.

The BOM class for the PMML TreeModel already exists.
If the PMML file you want to import has all or most of the fields already found in the
BOM class, do not generate another BOM class and ruleset parameter. Instead, use the
PMML Verbalization editor in the Import PMML Decision Tree Wizard to associate the
PMML elements of the new file with the corresponding members of the existing BOM
class. This is facilitated by the use of the mapping file.

After your PMML TreeModel file has been successfully imported, it becomes a standard
decision tree artifact and can be edited, managed, and deployed like any other decision tree.
An imported decision tree currently has no life-cycle link to the PMML file. Consequently,
if you change the PMML model itself, you have to repeat the import/modification process.

The import of PMML TreeModels containing compound or simple set predicates may
result in irrelevant messages being produced by the overlap and gap checker in the

Note:

decision tree editor. To remedy this, turn off overlap and gap checking at either the node
or tree level.
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Importing when the BOM class does not exist
The first time you import a PMML TreeModel file into a given rule project, there is no
corresponding BOM class and ruleset parameter. Similarly, when the PMML fields of the file
you want to import are completely different from the BOM class you generated in a previous
import, you need a new BOM class.

In either of these cases, let the Import PMML Decision Tree wizard generate a BOM class
and ruleset parameter by keeping the Generate BOM classes option enabled.

When you keep this option enabled, the Import PMML Decision Tree wizard creates a BOM
entry with a class containing all the members of the PMMLfile, creates a default verbalization
for each member, creates an instance of this class as ruleset parameter with a default
verbalization, and then uses this information to create the decision tree.

To import a PMML file as a decision tree when the required BOM class does not exist:

1. In Rule Designer, switch to the Rule perspective, and select the rule project in which you
want to import the PMML file.

2. Click File > Import, selectOperational DecisionManagement > Predictive Analytics
> PMML Decision Tree, and click Next.

3. In the Import PMML Decision Tree page, enter or browse to a valid PMML file.
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Make sure the PMML file conforms to the requirements and limitations
described in PMML support.

Important:

4. Make sure that the Generate BOM classes option is enabled and click Next.

The BOM Class Generation Options panel is displayed.
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The wizard proposes default values for the generated BOM class type and verbalization,
and the generated ruleset parameter name and verbalization. You can edit these if needed.

5. Keep Generate vocabulary mapping file and click Next.

With this option checked, the wizard also creates a vocabulary mapping file containing
the default verbalization associated to each PMML element. This mapping file can later
be reused when importing similar PMML TreeModel files.

6. Enter the name and location for the newBOMentry in which to store the PMMLmembers,
and then click Next.
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The folder field defines in which bom sub-folder the BOM entry is created. A
blank value means that the entry is generated directly under the bom top-level
folder.

Note:

7. Enter the name and location of the new decision tree, and then click Finish.

You can change the Type field if you have defined custom decision tree
extension classes and wish to have the new decision tree instance inherit from
one of these custom decision tree classes.

Note:

Your new decision tree is displayed:

You may get B2X errors and warnings until you create the corresponding XOM class, as
described in Integrating the decision tree into the rule project. Also, you can remove irrelevant
overlap and gap checker messages generated by the decision tree editor by turning off overlap
and gap checking at either the node or tree level.

Other messages are described in section Reference.Note:

Importing when the BOM class already exists
When a BOM class already contains all or most of the PMML TreeModel elements of the file
you want to import, do not generate another BOM class. Otherwise you will get redundant
entries in your drop-down lists.

Instead, uncheck theGenerate BOM classes option in the import wizard and use the PMML
Verbalization editor in the Import PMML Decision Tree Wizard to associate the PMML
elements of the new file with the corresponding members of the existing BOM class:
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In this editor, all the PMML elements of the new file are displayed in the PMML Elements
pane. Then, in the Verbalization pane, enter the verbalization for each field.

This step is facilitated by the use of amapping file, which you create when generating the
original BOM class, and then specify as a starting point for PMML verbalization. When you
specify a mapping file, you only need to provide a verbalization for PMML elements not
present in the original PMML file.

If you do not specify a mapping file, the PMML Verbalization editor suggests a default
verbalization for all the elements instead.

In either case, this verbalization of each PMML element is then used by the wizard to generate
the decision tree, but the verbalization information is not stored in the BOM entry, which
remains unchanged.

In a mapping file, each mapping field maps the PMML element with the element of the
vocabulary of the BOM entry. Here is an example:

To import a PMML file as a decision tree when the BOM class already exists:
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1. In Rule Designer, switch to the Rule perspective, and select the rule project in which you
want to import the PMML file.

2. Edit the BOM class to add, remove, or modify any members and their verbalization so
that it matches the PMML file you want to import.

3. Click File > Import, selectOperational DecisionManagement > Predictive Analytics
> PMML Decision Tree, and click Next.

4. In the Import PMML Decision Tree page, enter or browse to a valid PMML file.

Make sure the PMML file conforms to the requirements and limitations
described in PMML support.

Important:

5. UncheckGenerate BOMclasses, and select themapping file you created when generating
the BOM class. This may take a moment as the wizard retrieves model elements and their
verbalization. Then click Next to display the PMML Verbalization page.
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6. Verbalize all the elements found in the PMML file by selecting them one-by-one in the
PMMLElements pane and editing the Verbalization pane for each entry. The Verbalization
pane makes use of Content Completion to help you access any existing verbalizations
found in the BOM, typically the ones you created before importing.

If you specified a mapping file as a starting point to PMML verbalization, the
Verbalization pane automatically proposes the verbalization for PMMLelements
found in both the new PMML file and the mapping file.

Note:

7. Save the verbalization information in a mapping file if required, by checking Generate
vocabulary mapping file and specifying the destination. Then click Next.
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Make sure you correctly verbalize all the elements before clicking Next.
The wizard does not advise you of any missing verbalizations, which can
produce incorrect decision tree actions.

Important:

8. Enter the name and location of the new decision tree, and then click Finish.

You may get B2X errors and warnings until you create the corresponding XOM class, as
described in Integrating the decision tree into the rule project. Also, you can remove irrelevant
overlap and gap checker messages generated by the decision tree editor by turning off overlap
and gap checking at either the node or tree level.

See also
Overview
PMML support
Integrating the decision tree into the rule project
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Integrating the decision tree into the rule project
When you import a PMML file into a ecision tree with the option of generating the BOM
classes, Rule Designer generates the BOM class, which contains one attribute per PMML
field.

However, Rule Designer does not create a XOM class corresponding to the newly created
BOM entry. You must do this manually. Ideally you should do this before importing the
PMML file to avoid B2X errors, but you can also do it after.

To add the XOM class:

1. In the /src package of your XOM, create a class with the same name as the BOM
class, for example Decision_point.java.

2. In this class, add a public attribute for each PMML field contained in your generated
BOM class. For example:

public class Decision_point {
public double petal_length;
public double petal_width;
public double sepal_length;
public double sepal_width;
public String species;
}

3. Save your work.

Best practices around ruleflow orchestration suggest that each decision tree should be
contained within its own rule task (see the Operational Decision Management
documentation for additional information).

Note:

See also
Importing a PMML file to a decision tree
PMML support
Overview
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Invoking the SPSS Scoring Service
In Operational Decision Management, you can author business rules that reference predictive
scores, which are then retrieved from a scoring service when the business rules execute. Use
a scoring service when your analytic models change frequently, or when using models that
cannot be represented in rule artifacts.

The following image shows howOperational DecisionManagement integrates with the SPSS
scoring service:
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Retrieving models from the scoring service
To invoke a scoring service from a business rule, you first need to generate a XOM in
Operational Decision Management corresponding to the analytic models that you retrieve
from the scoring service. A XOM class for an analytic model is a proxy class usable by the
rule engine to invoke the model, by passing the right input data.

Retrieving models from the scoring service assumes that you have deployed and configured
themodels on the scoring service. The SPSS Scoring Service is available in SPSSCollaboration
and Deployments Services (C&DS), where you deploy analytic models using the Deployment
Manager. To retrieve the models in Operational Decision Management, you need the URL of
the scoring service (for example, http://somehost:port/scoring/services/
Scoring), as well as the login/password created in C&DS. See its documentation for more
information.

Retrieving the models from the scoring service must be done for each rule project where
invocation is used, as follows:

1. In Rule Designer, right-click the rule project and click Properties.

2. Select SPSS Scoring Service.

3. Specify the connection parameters to the SPSS Scoring Service:

♦ The URL of the scoring service or the URI of the WSDL.

♦ The login/password.

The login andpassword are encrypted and stored in theXOMheader
and in the Eclipse workspacemetadata. The key used to encrypt the
data cannot be changed.

Warning:

4. Click Refresh. The available models are displayed.

5. In the Models section, select the models you wish to import:
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6. Click OK.

All the models are now available in package com.ibm.rules.analytics/ in the
XOM file spss.scoringservice.models.xom, in the resources folder.

In addition, the following JAR files are referenced in the rule project as XOM entries:

♦ <WODMInstallDir>/SupportPacs/SupportPacLB02/lib/

velocity-1.5.jar

♦ <WODMInstallDir>/SupportPacs/SupportPacLB02/lib/

commons-collections-3.1.jar

♦ <WODMInstallDir>/SupportPacs/SupportPacLB02/lib/

commons-lang-2.1.jar

♦ <WODMInstallDir>/SupportPacs/SupportPacLB02/lib/

jrules-analytics-runtime.jar
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Understanding the generated XOM
The generated XOM class is a representation of the SPSS models in a model executable by
Operational Decision Management.

These XOM classes contain:

♦ A constructor with no arguments.

♦ Some fields: Each field has a name, a type, and some properties: (Note: Do not change
these).

● The InitialName property: Contains the name of the field in the analytic model. The
name of the field changes if the initial name contains spaces or special characters.

● The Direction properties can be one or more of the following:

♦ Required: A required input field.

♦ Optional: An optional input field.

♦ Returned: An output field.

♦ AgetScore()method: All the required fieldsmust have a valuewhen callinggetScore
(), otherwise an exception is thrown. The getScore() method invokes the scoring
service, and then sets a value on all the returned fields. You can choose which fields to
make use of.

♦ A reset() method: Returns the object to its initial state.

The following example shows a typical XOM class:

package com.ibm.rules.analytics.spss.scoringservice.models;

public class PatientKMeans
property InitialName "PatientKMeans"
property "ilog.rules.engine.driver" "com.ibm.rules.analytics.bom.ScoringDriver"

{
public PatientKMeans();

public double Age
property Direction "required"
property InitialName "Age";

public string BP
property Direction "required"
property InitialName "BP";

public string Cholesterol
property Direction "required"
property InitialName "Cholesterol";

public string Drug
property Direction "required"
property InitialName "Drug";

public double K
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property Direction "required"
property InitialName "K";

public double Na
property Direction "required"
property InitialName "Na";

public string Sex
property Direction "required"
property InitialName "Sex";

public string Prediction
property Direction "returned"
property InitialName "Prediction";

public void getScore();

public void reset();
}

Creating methods to invoke the scoring service
After you have generated the XOM corresponding to the analytic models retrieved from the
scoring service, you must create BOM methods that invoke the scoring service, so that they
are usable in your business rules after verbalization.

To start this, you can either:

♦ Create a newBOM entry from your generated XOM, and then create a virtual BOMmethod
for the invocation.

♦ Create a virtual BOM method in an existing BOM class.

Then, add code to the BOM to XOMMapping section of the virtual BOM method so that
it sets the required fields and calls the getScore() method.

The following example shows a getPrediction() method, added to an existing BOM
class Patient, that defines the same attributes as the PatientKMeans BOM class (Age,
Sex, BP, and so on). This getPrediction() method is defined as follows:

1. In the Edit the imports section:
// Imports the XOM classes from the scoring service package.
import com.ibm.rules.analytics.scoringservice.models.PatientKMeans();

2. In the Body section:
// Creates a new object to invoke the analytic model
PatientKMeans obj = new PatientKMeans();

// Set the fields. All the required fields must be set.
obj.Age = this.Age;
obj.Sex = this.Sex;
obj.BP = this.BP;
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obj.Cholesterol = this.Cholesterol;
obj.Na = this.Na;
obj.K = this.K;
obj.Drug = this.Drug;

// Invoke the analytic model, now that the inputs are filled.
obj.getScore();

// Return one of the computed result (the score).
String res = obj.Prediction;
return res;

Typically you write this code in the B2X body of the BOM method, but it can be written
anywhere you write XOM-based IRL.

Note:

Invoking a scoring service
You can invoke the scoring service from Rule Designer or from an Enterprise Application.

You can also use Decision Validation Services to test the invocation of the scoring
service. See the Testing and simulating rulesets section of the Operational Decision
Management documentation.

Note:

Invoking a scoring service from Rule Designer
You can test that the invocation of the scoring service is working by executing the rule project
in Rule Designer.

To execute in Rule Designer using the SPSS Scoring Service:

1. In Rule Designer, select the rule project and click Run > Run Configurations.

2. In theRun Configurations panel, right-click theRule Project category and chooseNew
to create a new launch configuration.

3. Click Browse in the Rule Project tab and select the rule project.

4. Click Apply, and then Run.

Invoking a scoring service from an enterprise application
To use the scoring service invocation from enterprise applications forWebSphere Application
Server 7, you must package the four runtime JAR files located in <WODMInstallDir>/
SupportPacs/SupportPacLB02/lib/ to myWar.war/WEB-INF/lib.

If you have several WAR files within a same EAR, and some of the JAR files are shared
among two or moreWARfiles, you canmove some of the JAR files one level up, for example:
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♦ META-INF

♦ shared.jar

♦ w1.war

♦ w2.war

♦ w3.war

Here, w1.war, w2.war, and w3.war share the same JAR file called shared.jar.
Therefore, you can move shared.jar up one level, directly under the EAR.

Also, reverse the class loaders when you package the EAR file and deploy WebSphere
Application Server 7. Reverse the class loaders for all the WAR modules, and for the EAR
itself. For more details, consult the WebSphere Application Server 7 documentation.

See also
Product overview
Type support for scoring service invocation
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Reference

Reference information on error messages and supported data types.

In this section

PMML import messages
Description of warning or error messages displayed during PMML import.

Type support for PMML import
Supported data types for PMML import.

Type support for scoring service invocation
Supported data types for scoring service invocation.
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PMML import messages
The following table lists warning or error messages displayed during PMML import:

DescriptionTextID

Wizard points to a PMML or
mapping file that does not exist.

File does not exist.P2J0008

IOException while reading the
contents of a PMML file.

Could not read PMML file.P2J0020

PMML version not detected.Could not detect PMML version.P2J0021

PMML version not supported.Unsupported PMML version.P2J0022

Error while parsing the PMML file.Could not parse PMML.P2J0023

PMML file contains a XOR.Unsupported PMML feature.P2J0024

Only TreeModel is supported.No TreeModel found in PMML file.P2J0027

See limitations on surrogates in
PMML support.

The imported PMML file contains
surrogates. The first predicate of

P2J0028

each surrogate was included in the
tree.

See limitations on dates and times
in PMML support.

The imported PMML file contains
date or time types that are treated as
integers.

P2J0029

IOException while reading the
contents of a mapping file.

Could not read mapping fileP2J0040

XMLException while parsing the
mapping file.

Could not parse mappingP2J0041

Code asked the DataTypeMapper
class to convert a temporal type

Can only convert temporal types to
date or time, not <X>.

P2J0042
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DescriptionTextID

besides date, time, or dateTime to
a BAL string.

See limitations in PMML support.All children of the same node in the
PMML tree must test the same field

P2J0043

(i.e. only univariate split are
supported).

Field must exist in DataDictionary.A field named <X> was used in a
PMML predicate, but does not exist
in the PMML DataDictionary

P2J0050
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Type support for PMML import
The following table lists the supported data types for PMML import into Operational Decision
Management decision trees and the mapped Java type:

Mapped Java
Type

DescriptionType Name

java.lang.StringA stringstring

intAn intinteger

floatA floatfloat

doubleA doubledouble

java.util.DateXML compliant date typedate

java.util.DateXML compliant date type (time
only)

time

java.util.DateXML compliant date type (a date +
a time)

dateTime

intDate, represented as number of
days since year 0 (for ex: 1980 is
1980)

dateDaysSince[0]

intDate, represented as number of
days since year 1960

dateDaysSince[1960]

intDate, represented as number of
days since year 1970

dateDaysSince[1970]

intDate, represented as number of
days since year 1980

dateDaysSince[1980]

intPMML specific date typetimeSeconds

intDate expressed in elapsed
seconds since year 0

dateTimeSecondsSince[0]

intDate expressed in elapsed
seconds since year 1960

dateTimeSecondsSince[1960]

intDate expressed in elapsed
seconds since year 1970

dateTimeSecondsSince[1970]

intDate expressed in elapsed
seconds since year 1980

dateTimeSecondsSince[1980]
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Type support for scoring service invocation
The following table lists the supported data types for scoring service invocation from
Operational Decision Management and the mapped Java type:

Mapped Java TypeDescriptionType Name

booleanA booleanboolean

intAn intinteger

longA longlong

floatA floatfloat

doubleA doubledouble

doubleA decimaldecimal

XMLGregorianCalendarA date (W3C compliant)date

XMLGregorianCalendarA time (W3C compliant)daytime

XMLGregorianCalendarA date and a time (W3C compliant)timestamp
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Glossary

decision tree
The Operational Decision Management artifact created from the imported PMML file.

Decision Tree model
The model in the Predictive Modeling tool (SPSS Modeler, SAS Enterprise Miner) where
these models are usually created. They are represented and stored in a proprietary format.

PMML TreeModel
ADecision Tree model once it has been exported from themodeling tool and is in a PMML
file.

© Copyright IBM Corp. 1987, 2012 43

G L O S S A R Y


	WebSphere Operational Decision Management LB02 SupportPac Documentation
	Table of contents
	Product overview
	Installing
	Importing PMML in Operational Decision Management
	Overview
	PMML support
	Importing a PMML file to a decision tree
	Integrating the decision tree into the rule project

	Invoking the SPSS Scoring Service
	Reference
	PMML import messages
	Type support for PMML import
	Type support for scoring service invocation

	Glossary


